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Using the FPF System for Forecast Maintenance 

Objectives 

In this chapter you will: 

rn Log on to the FPF System. 

Change the way data is displayed in the D-Cube 
window to make data inputting easier. 

Input forecast data by using commands and 
shortcuts. 

Print D-Cube information. 
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Using the FPF System for Forecast Maintenance 

You must be logged on to the PEC local area network 
and Windows NT in order to use the FPF System. 

Logging On to the 
FPF System 

1. Double-click on the FPF Manager icon. 

2. Enter your user name. 

4. ChooseOK. 

w Passwords can only be changed by a System Administmtor. 

Understanding the 
D-Cube Window 

It is important to understand how data is displayed in the 
D-Cube window before you begin to input or revise data 
within the FPF System. The D-Cube window resembles 
an Excel spreadsheet. It is composed of cells arranged 
as rows and columns. D-List item names are used as 
row and column heading labeis in D-Cubes. 

Formula item names appear in black text and detail item 
names appear in blue text. The same color coding is 
used for data within the DCube grid. 

Each D-List of a DCube is given a group box. The group 
box displays the name of the active item in the D-List If 
you move the mouse pointer over a group box, the DList 
name appears. 

The D-Cube window for other costs is displayed on the 
next page. This D-Cube contains fwe D-Lists that appear 
as fwe group boxes in this D-Cube window. The group 
box located in the upper right hand-corner of a D-Cube 
window identifies the D-List that is used for column 

~ 
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headings. The group box located in the lower left-hand 
comer of a D-Cube window identifies the D-List that is 
used for row headings. 

Other D-Lists within this P 
Cube are displayed as Group 

Boxes with the active item 
shown in each box 

for Row Headings Group Box used for 
Column Headings 

The D-Cube window above displays other costs for the 
current forecast year related to material for operating 
area 1 I000849 (area 0849 within company 11 00). Notice 
that the cell within the grid that is currently selected lies in 
the row labeled “Total Function” and the column labeled 
“Oct.” The group boxes displayed in the lower left-hand 
and upper right-hand corners also reflect these same 
active D-List items. 

Other costs are grouped into fwe categories in the FPF 
Sys temate r ia l  costs, transportation costs, costs for 
outside services, other miscellaneous costs and total 
costs. The contents of the grid within the DCube window 
shown above are related to material costs. We know this 
because ‘Material” is shown as the active item in the 
group box associated with the D-List related to the 
categories of other costs. 

As you are maintaining an area’s forecast, you most likely 
will need to change the active items and the way data is 
displayed within the D-Cube window before you begin 
entering or revising the data within the grid. The lessons 
that follow will help you display the data within the D- 
Cube window in the desired manner. 
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Activating a Different 
D-List Item in the D-Cube 
Window 

Follow the steps below to activate a different D-List item 
associated with a particular group box in the D-Cube 
window. For example, if you would like to enter 
transportation costs instead of material costs in the D- 
Cube window displayed on the previous page, you would 
follow the steps below. 

1. Click on the white area within the appropriate group 
box. 
The Select an /tern list appears as shown below. 

2. Select an item name from the list, or type the first 
part of the item name you want. 

The group box now displays the selected D-List 
item and the selected item is now active within the 
D-Cube window grid. 

3. ClickGoto. 
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Rearranging the Group 
Boxes in the DGube 
Window 

Unlike an Excel spreadsheet, the D-Cube window is 
multi-dimensional. The row and column items are easily 
interchangeable. Thus, the D-Lists within the D-Cube 
window may be moved to different positions simply by 
rearranging their associated group boxes. 

1. Click on the square on the left side of the group box 
that you want to reposition. 

2. Drag this group box on top of the group box that you 
want it to exchange positions with. 

w For exampie, using the D-Cube displayed on the previous 
page, if you would like the Other Costs D-List to be 
displayed as columns and the Versions D-List to be 
displayed as rows, then foiiow the steps above to change 
their position in the D-Cube window. The end result is 
shown below. 
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to first cell in the grid (upper 
to last cell in the grid (lower 

Activating a Cell for 
Data Entry 

Once the D-Cube window is arranged the way you want 
it, you can begin to enter or revise the data contained 
within the cube. First, you must select or activate the cell 
within the grid before you can enter or revise data within 
it. There are two ways to select a cell within the D-Cube 
grid. 

1. Click the desired cell to select it. 

- Or 

1. Click on the associated group box. 
The Select an Item list appears. 

Select an item name from the list, or type the first 
part of the item name you want. 

2. 

3. Click Goto. 

w To select a range of cells, click the first cell of the range 
and drag to include the other cells. You also can press the 
SHlFT key in conjunction with any of the keyboard 
shortcuts discussed next. 

Using Keyboard 
Shortcuts 

You also can change the active cell using keyboard 
shortcuts. The most useful keyboard shortcuts are 
described below. 

- 
Move 
Move 
__ 
- 

' left comer). 
right comer). 

Move down one screen. I - 
Move - up one screen. 
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Editing Cell Content 
Users are not allowed to change the content of all cells 
within the system’s D-Cubes. Users themselves also can 
prevent the content of selected cells from being updated 
or revised by others or by the system itself by protecting, 
holding or locking the selected cells. If a cell is locked, it 
has a gray background. If a cell is protected, it has a 
yellow background. If a cell is held, it has a turquoise 
background. The difference between locked, protected 
and held cells will be explained in more detail later in this 
course. 

The content of cells with a white background are not 
protected or locked and can be changed by users. 
Follow the steps below to change the contents of an 
unlocked or unprotected cell. 

1. Select the cell. 

2. Change the contents. 

3. Press ENTER. 

w To cancel cell changes, press ESC rather than ENTER. 

Understanding Cell 
Color Coding 
Conventions 

The FPF System has a standard color coding convention 
to show changed and unchanged cell data or content. 

w lfyou forget to press the ENTER key afferyou change the 
contents of a cell, the data you inpuffed will be green. 

Financial Planning and Forecasting System 37 



Contributor Course 

Saving Data Input 
Before you exit or close the D-Cube you currently are 
working on, you must remember to save your changes. 
Otherwise, the information you entered will be lost and 
will need to be reentered. There are two ways to save 
your data input. 

w &t: Save offen. 

II 

1. Click on the Save icon bicture of a disk) .. 
on the tool bar. 

I .  Select Save from the File menu. 

w If you forget to save a repod or D-Cube, a message will 
appear. The message wi// ask if you want to save the D- 
Cube OT report before closing. If you do, choose yes". 

Using Shortcuts to Input 
Large Numbers 

You can enter data directly into a detail item cell within 
the D-Cube window grid to change its contents. You also 
can use a variety of data entry shortcuts and commands 
to speed up the data entry process. The system provides 
the following two shortcuts to make entering large 
numbers easier. 
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, . _  
COPY UP A 

Copy down 
Break (Stop) 

I 

Copying Cell Content 
Data can be copied across columns and rows using 
standard copy-paste methods or by using the copy 
commands below. 

c= This symbol Is located 
Wr the key below the 
Backspace key. 

I c I Co~vlefl I 

per 
inc 
dec 

Take % of 
Increase by % 
Decrease bv % 

25% of 100=25(ENTER)perlOO(ENTER) 
Increase 10 by 20%=1O(ENTER);nc20(ENTER) 
Decrease 30 bv 5%=30fENTERIdec51ENTERl 

You do not have to indude the number to be copied wlul the copy 
command. For example, if you type 2K in a cell and press 
ENTER, you wuid copy this number (2,000) to the right by typing 
only > in the same ceii and pressing ENTER. 

Copy commands are terminated when they find another 
command or a mlon, or by unprocessed numbers. For example, 
rfyou enter 1Kz in the October cell and a colon in the March cell, 
then 1,000 will be copied into the October through February cells. 

Using Arithmetic 
Commands 

The system provides eight arithmetic commands as 
outlined in the table below. These commands perform 
mathematical calculations as you enter them along with 
numbers into a cell. The arithmetic commands save time 
because the calculations do not have to be done prior to 
data entry. Instead, the calculations are done 
simultaneously with data entry. 

The FPF System’s arithmetic commands are very 
different than the commands used in Microsoft Excel. 
They must be entered in a special way. A number must 
be entered after each command listed below followed by 
depression of the ENTER key. 

POW I Raise to power 1 Raise 7 to the 4m power=7(ENTER)pow4(ENTER) 
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Breaking Back a Total 
A break-back is a specific amount allocated back to the 
cells that make up a total pro rata. Break-backs can only 
be used in cells containing formulas. Follow the steps 
below to break back a total. 

1. 

2. 

Select the appropriate total cell. 

Enter the number to be allocated back to the cells 
that make up the total pro rata. 

3. Press ENTER. 

w Examole: Your area plans to spend $12,000 over a I-year 
period. The costs are to be spread equally over the 12 
months within that I-year period. Enter 12000 in the total 
cell for the 1-year period. The system will break back the 
total equally over the cells that make up the total. The end 
result--$1,000 will be contained in each of the 12 cells that 
correspond to the months within the I-year period. 

lfyou want to allocate the $12,000 back to only 3 months 
out of the year, enter a 1 in each of the cek  for the 3 
months followed by the ENTER key. A 3 will appear in the 
fiscal year total cell. Then enter 12000 in the fiscal year 
total cell and 4000 will appear in each of the cells for the 3 
months. 
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protect or p 

lock or I 

Holding, Protecting or 
Locking Cell Content 

A hold on a cell prevents its content from being changed 
by break-backs. A lock on a cell prevents its content 
from being overwritten by automatic system updates or 
by links. Input changes cannot be made on a protected 
cell, but it can be overwritten by system updates and 
links. If one of these commands is in effect, the cell's 
background color changes to provide a visual alert to the 
user. Use the appropriate command below to prevent 
cell content from being changed a certain way. 

. 
break-back. 
Prevents a cell from input change, but allows 
break-backs and updates through links. 
Locks a cell so that it cannot be updated by a 
link. A locked cell can be changed by a 

yellow 

gray 

release or r 
break-back. I 
Removes the cell from hold. 
(See other options below.) 

Removing Protection, 
Lock or Hold on Cell 
Content 

Follow the steps below to remove protection, lock or hold 
on cell content. 

1. 

2. 

Select or highlight the cell. 

Select the Commands option from the D-Cube 
menu on the menu bar. 

Select the desired optiow-hprotect, Unlock or 
Release. 

3. 

- Or 

1. 

2. 

Right click on the desired or highlighted cell. 

Select the desired option-Unprotect, Unlock or 
Release. 
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Growing Cell Content by 
an Inflation Factor 

Operating areas commonly apply inflation factors when 
predicting non-labor costs for future forecast years. This 
easily can be done within the FPF System using the grow 
command. 

1. Input the current cost amount in the appropriate 
cell. 

2. Press ENTER. 

3. Type “growxc“ in the same cell, where x represents 
the inflation factor to be applied. The c refers to 
compounding. 

4. Press ENTER. 

w ExamDIe: The command “grow3c” will cause the 
corresponding costs for future forecast years to grow by 
3% compounded each year. 

The organization of the D-Cube window is important when 
using the grow command. Refer to the ‘Special Tips’ 
section of this manual for guidance when using this 
command to inflate Other Costs in future forecast years. 

Zeroing Cell Content 
Occasionally, you might have the need to zero out the 
contents of a cell, a group of cells or all of the cells in an 
entire D-Cube. You can do this by following the steps 
below using the zero command. 

1. Choose Commands from the D-Cube menu on the 
menu bar. 
A pick list of commands with the associated 
command options appears as shown below. 
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2. Select zero from the command pick list. 
Zero should now be highlighted. 

Click on the appropriate command option button. 
Choose: 

Marked Selection if you previously selected or 
highlighted the cell or cells you would like zeroed 
out. 

3. 

- Or 

Select if you have not yet selected or highlighted 
the cell or cells you would like zeroed out. 

When you choose this option, a tab will be provided 
for each D-List within the D-Cube that is currently 
active. To select the desired D-List, click on its 
corresponding tab. A pick list of the items 
contained in the selected D-List wil/ be displayed. 
Highlight the D-List item(s) you would like zeroed 
out. Then, move the selected itemls) to the right by 
clicking on move >. If you selected an item 
incorrectly, simply move it back to the le# by 
highlighting it and clicking on move <. Click OK 
when your selection is complete. 

Select All if you would like to zero out the contents 
of the entire D-Cube. 

c$ Warning: 
All cells within all dimensions of fhe active D-Cube 
will be cleared out when you choose the Select All 
option. This option should be rarely, if ever; used. 

4. Click OK. 
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Copying Data into a 
D-Cube from Another 
Application 

You can copy data into a D-Cube from other sources 
such as an Excel spreadsheet, an Access database, or a 
Word text file. Use the Windows clipboard to copy data 
into a D-Cube from another application using the steps 
below. 

1. 

2. 

3. 

4. 

Highlight the information within the source 
application that you want to copy. 

Copy the selected information to the Windows 
clipboard using standard copy-paste methods. 
(Click on the copy icon on the tool bar or press 
CTRL and C simultaneously.) 

Return to the FPF System. 
(Click on FPF Manager in the task bar or press ALT 
and TAB simultaneously unfil FPF Manager 
appears.) 

Paste the information from the Windows clipboard 
to the target D-Cube within the FPF System using 
standard copy-paste methods. 
(Click on the paste icon on the tool bar or press 
CTRL and V simultaneously.) 

w Don? forget to save the information you just copied to the 
D-Cube. 
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Adding, Changing, 
Viewing or Deleting a 
Cell Annotation 

An annotation is a note added to a cell by a user. 
Annotations are useful for providing additional information 
about a particular cell. If an annotation exists for a cell, a 
red flag appears in the upper left-hand corner of the cell. 
Follow the steps below to add, change, view or delete a 
cell annotation. 

1. 

2. 

3. 

4. 

1. 

2. 

3. 

4. 

5. 

Right-click on the appropriate cell. 

Select Add Annotation to add a new annotation, 
Edit Annotation to change an existing annotation, 
Show Annotation to look at an existing annotation, 
or Delete Annotation to remove an existing 
annotation. 

Type in the new or changed annotation, when 
appropriate. 

Click OK. 

- Or 

Highlight or select the appropriate cell. 

Select Annotations from the D-Cube menu on the 
menu bar. 

Select AddlEdit to add a new annotation or change 
an existing annotation, Show to look at an existing 
annotation, or Delete to remove an existing 
annotation. 

Type in the new or changed annotation, when 
appropriate. 

Click OK. 
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Suppressing Zeros in a 
D-Cube 

You might find it helpful to see only relevant non-zero 
information displayed in the D-Cube window. You can 
hide D-Cube rows, columns and pages that do not 
contain relevant information by following the steps below. 

1. Open the appropriate D-Cube. 

2. Select Options from the D-Cube menu on the 
menu bar. (Various tabbed options will be 
displayed.) 

Click on the Zeros tab. 3. 

4. Select Suppress Zero Rows, Suppress Zero 
Columns, Suppress Zero Pages or any 
combination of these three options. 
&to hide all zero items in a particular D-List, 
highlight the desired D-List in the Suppress Zero 
Items for D-List(s) box. (To remove zero 
suppression from the d-list click Clear.) 

- Or click on All to hide all zero items in all D-Lists 
pertaining to the current D-Cube. 

5. ClickOK. 

w Save the D-Cube if you want irrelevant information to remain 
suppressed. Use Suppress Zero Pages to prevent blank pages 
from being printed or expofted to anothwr tile. If yw suppressed 
zero rows, then all zero RYWS will be hidden regadless which P 
List makes up the rows in the 0-Cube window. 
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Printing D-Cube 
In fomat ion  

Although the FPF System does not provide users with a 
print screen option, it does provide options for printing D- 
Cube information. You can print all or selected parts of 
the information contained within a D-Cube by following 
the steps below. 

1. Select Print from the File menu on the menu bar. 
A box containing various tabbed options will 
appear. The box will allow you to select the 
informafion to be printed from the various D-Cube 
dimensions. 

Select the information you would like printed using 
one or more tabbed options. 

To select specific data to be printed, highlight the 
data you wish to print and move it to the Items 
included area. 

2. 

ET If you do not select anything, then a// of the items will print 

3. ClickOK. 

and the report may be vew /age. 

Including a Cell 
Annotation with Printed 
D-Cube Information 

If you would like a cell annotation to print at the bottom of 
the page, follow the steps below before you print the D- 
Cube information. 

1. Select the annotated cell. 

2. 

3. 

Select Print from the File menu on the menu bar. 

Select the items to be printed by moving them to 
the items included box. The items containing the 
annotations must be selected. 

Select Print at the bottom of the page in the 
Annotations area. 

4. 

5. Click OK. 

w The annotation will print at rhe bottom along wYh the cell’s 
location, creator’s name, date, and time. 
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Viewing Linked 
Information Using the 
Drill Down Feature 

The system's drill down feature lets you analyze D-Cube 
data that was imported into a DCube cell by a D-Link. 
You can drill down on any single cell in a D-Cube. If the 
cell contains data transferred by a D-Link, drill down 
opens a view of the source data. If the data was 
imported from another D-Cube, drill down opens the 
appropriate selection from the source D-Cube. If the data 
was imported from an external source (a mapped ASCII 
file or an ODBC database), drill down extracts the 
relevant data from the source file and displays it in a 
special drill-down results dialog box. You can also drill 
down on any two-dimensional range of cells in a D-Cube. 
Follow the steps below to drill down and view data linked 
to a cell. 

1. Select the cell you want to drill down to view its 
linked data. 

2. Click on the drill down icon on the tool bar. 
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Viewing and Printing A Summary Report 

Objectives 

In this chapter you will: 

View a summary report. 

Change the way the report is displayed. 

Add a scroll bar to a summary report. 

Print a summary report. 

Exit the FPF System. 
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Viewing and Printing A Summary Report 

The FPF System provides five types of summary reports 
to contributors. The reports pertain to labor costs, other 
costs, total costs, intercompany billing percentages and 
redistribution. The pages that follow discuss ways for 
users to change the appearance of these reports to best 
suit their needs. 

Changing a Summary 
Report Display 

Just as data can be rearranged within the D-Cube 
window, data can also be rearranged within a summary 
report. The procedures are the same. Thus, you can 
specify the D-List items to be displayed in a report, as 
well as select the D-Lists that are used as the report rows 
and columns. Users can change the report display for 
viewing purposes or prior to submitting the report to be 
printed. 

a Refer to the sections in the previous chapter entitled 
"Activating a Diferent D-List /tern in the D-Cube Window" 
and "Rearranging the Group Boxes in the D-Cube Window" 
for help with these procedures. 
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Suppressing Zeros in a 
Summary Report 

Just as irrelevant data can be suppressed within the D- 
Cube window, irrelevant data also can be suppressed 
within a summary report. Zeros can be suppressed 
either when viewing a report on the screen, when printing 
or both. Follow the steps below to prevent report rows 
and columns that contain irrelevant (zero) data from 
appearing in a report. 

1. Navigate through the FPF System user menus until 
the desired report is displayed on the screen. 

Select Options from the Table menu on the menu 
bar. 

2. 

3. Select Screen, Printer or both for Zero 
suppression by row or column within the 
corresponding Row dirnension(s) or Column 
dirnension(s) section. 

Click on the Check button. 4. 
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Adding a Scroll Bar to a 
Summary Report 

Follow the steps below to add a scroll bar to a report. 

1. Navigate through the FPF System user menus until 
the desired report is displayed on the screen. 

I scroll I 
2. Select User Options from the File menu on the 

menu bar. 

ars 

7 
1 
L 

3. Check the box for Veritcal and/or Horizontal scroll 
bars within the Scroll Bars section. 

Click on the Check button. 4. 

w When you add scroll bars fo a report, only one line will 
scroll at a time. 
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Printing a Summary 
Report 

Follow the steps below to print one of the FPF System’s 
summary reports. 

1. Navigate through the FPF System user menus until 
the desired report is displayed on the screen. 

Select Print Report from the File menu on the 
menu bar. 

Select the desired D-List items from the pick list to 
change the report display if desired. 

report will print as it appears on the screen. 

2. 

3. 

IB I f  nothing is selected from the D-List item pick list, the 

4. ClickOK. 

Exiting the FPF System 
Similar to other PC applications, there are three ways to 
exit the FPF System as described below. 

1. Click on the Exit button located in the upper right- 
hand comer of any user menu within the FPF 
System. 

- Or 

Click on the X located in the right corner of the 
screen’s ti le bar. 

1. 

1. Choose Exit from the File menu on the menu bar. 
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Glossary of Terms 

Actual Data 

Arithmetic 
Command 

Annotation 

Budget 

Break-Back 

Capital Expense 

Copy Command 

D-Cube 

D-Link 

D-List 

Detail Item 

Expense 

Actual data reflect costs after they are incurred. Actual data is 
brought into the FPF System from the General Accounting 
System, SAP and Peoplesoft after the months final financial 
statements have been prepared. 

An arithmetic command is a shortcut that enables a user to 
perform a mathematical calculation while inputting data into a cell. 

An annotation consists of additional notes provided by a user 
about a cell and its content. A red flag appears in the upper left- 
hand corner of a cell if the cell is annotated. 

A budget is a prediction of an area’s future financial status for the 
current fiscal year. It is set through officer approval at the end of 
the previous fiscal year. Once set, the budget cannot be 
changed. It is used throughout the year to compare variances 
between the initial prediction and the actual financial outcome. 

A break-back is a user-specified total amount that is inputted into 
a formula cell that contains a total. The break-back amount is 
allocated back to the cells that make up the total pro rata. 

A capital expense is an oufflow of cash associated with the 
improvement to or addition of assets. 

A copy command is a data entry shortcut that copies data in a cell 
to the right, left, up and/or down the rows and/or columns of the 
grid displayed in the D-Cube window. 

A D-Cube is a multidimensional table made up of two or more D- 
Lists. The D-Lists supply the D-Cube row, column and page 
labels, as well as the formulas for calculations. 

A D-Link transfers data between D-Cubes or from an outside 
source into a D-Cube. The outside source may be an ASCII file 
or ODBC file, including SQL database, Excel and Access files. 

A D-List is a list of related items such as products, customers, 
months, etc. 

A detail item is an item in a D-List that does not contain a formula 
and is usually composed of input data. 

An expense is an oufflow of cash or other assets, or incurring 
liability that applies to a specific time period and resuits from 
carrying out ongoing business. 
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Forecast An area's fiscal year forecast is the same as its budget at the 
onset of the fiscal year. As the year progresses, forecasted data 
is replaced with actual financial data on a month-by-month basis. 
Eventually, at year-end, the entire forecast is comprised of actual 
data. 

Forecast+l 

Forecast+2 

Forecast+3 

Formula Item 

Group Box 

Hold 

Internal Order 

Lock 

Macro 

Operating 
Revenue 

Protect 

The forecast+l is a prediction of an area's future financial status 
for the fiscal year one year beyond the current fiscal year. 

The forecast+2 is a prediction of an area's future financial status 
for the fiscal year two years beyond the current fiscal year. 

The forecast+3 is a prediction of an area's future financial status 
for the fiscal year three years beyond the current fiscal year. 

A formula item is an item in a D-List that contains a formula for 
calculation. 

Each D-List displayed in a D-Cube window is given a group box. 
The group box displays the name of the active item in the D-List. 
If you move the mouse pointer over a group box, the D-List name 
appears. 

A hold on a cell prevents the cell's contents from being changed 
by a break-back. When a hold is placed on a cell, the cell's 
background is turquoise. 

An internal order is an additional break down of costs used by 
diversified companies within the SAP system. Internal orders are 
used to capture all costs for assets under construction, project 
costs that are not capital in nature, or additional information. 
Internal orders are used when the general ledger account and 
cost center alone or together do not provide enough detail to 
adequately describe the nature of the costs. 

A lock on a cell prevents the cell's contents from being changed 
by user input or through a link. However, locked cells are still 
vulnerable to break-backs. The cell's background turns gray 
when it's locked. 

A macro is a set of commands used to automatically complete a 
list of pre-recorded instructions in one step. 

Operating revenue is revenue earned through the daily course of 
doing business, such as cash received for the sale of goods and 
services. 

Protect on a cell prevents the cell content from input change, but 
allows updates by break-backs and links. The cell's background 
is yellow when it is protected. 
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Release 

Revenue 

A release removes a hold on cell content. 

Revenue is an inflow or an enhancement of assets incurred 
during a specific time period resulting from carrying out on-going 
business. 
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Code Definitions 

This section of the manual defines some of the cades 
most frequently used within the FPF System. 

Operating Area and Cost 
Center Codes 

Each operating area or cost center has an eight-digit 
number associated with it. The numbering scheme is the 
same as that used in the SAP system. The first four 
numbers denote the PEC subsidiary. The last four 
numbers represent the operating area or cost center. 

EXamDle: 11000849 => 1100 0849 

11 00 denotes PGL. 

0849 denotes the Executive O fke  of 
Accounting and Finance. 

Overtime Status Codes 

Employee Status Codes 

X I Normal h a v  at straiaht time rate) I 

, - - .  
IF I Inactive full-time 
IP I Inactive part-time 
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Union Worker Employee 
Category Codes 

Financial Planning and Forecasting System 58 



Contributor Course 

Special Tips 

This section of the manual provides special tips to help 
you use the FPF System for forecast maintenance. The 
tips are grouped into two categories-labor costs, and 
other costs--similar to the way costs are organized within 
an operating area or cost center’s forecast. It is 
recommended that you review the tips below before you 
begin the forecast maintenance process. If you need 
additional assistance, feel free to call one of the System 
Administrators listed below. 

FPF System Administrators 

I Terrv Flemina I 3934 I - 
Beth Ann Castaneda I 7340 
Kara Curnmings I 3693 

I Diana Cantwav I 4275 I 

Tips for Working With 
Labor Costs 

Accountina for ErnDlovee Promotions 

Users may forecast the promotion of individual 
employees in their area by changing their employee 
category and using the promotional increase 
percentage field. Users need to copy these changes 
across the future months so that the forecast reflects 
the promotion for all the future months. Then, users 
need to lock the employee category and promotional 
percentage to avoid it being overwritten when the 
PeopleSofl information is brought in the next month. 
However, when the locked month becomes an actual 
month, the lock must be removed from that month or 
the actual data will not flow through to the actual 
month’s employee category or promotional cells in the 
d-cube. The actual month’s data will then be incorrect 
if the lock is not removed. 

In order for the employee’s STlC and merit 
percentages to change to reflect his or her new 
category, the user must save and exit the d-cube and 
go back in. When a user reopens the d-cube, the new 
STlC and merit percentages should be reflected. A 
user must also exit and re-enter the d-cube if an 
employee status was changed as well in order for the 
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fringe benefits rate to change. The fringe benefits 
calculation in this d-cube is informational only and not 
used anywhere else in the FPF. 

The system will not be able to calculate pay increases 
based on the employee category when an employee is 
promoted to a new level. The user will have to 
estimate what the employee’s pay rate will be with the 
promotion. The user will enter the pay increase into 
the d-cube as a promotional percentage. The dcube 
formula will then take the percentage and multiply it by 
the employee’s starting hourly rate to arrive at the 
employee’s new pay rate after promotion. 

If an employee reduction is planned, the regular hours 
worked in a period need to be zeroed out for an 
employee or employees within the given employee 
category. Then, no additional data will generate for 
that employee or employees within the FPF system 
and they will not be contained in the forecast. 

m Although data wil be entered for a specific employee, this 
does not have to be the individual that is reduced. 

P S  

Users will enter the new employee’s name if known, job 
description, employee category, status, and overtime 
status. This information should be entered in the month 
the new employee is predicted to be hired. Employee 
category, status, and overtime status need to be carried 
across to all future months. The information should be 
copied across all the future months so that the new 
employee’s labor costs are induded in all the forecasted 
months and years. 

Assurina New EmDlovees are not Double-Counted 

When the new employee becomes part of the area’s 
payroll, the new employees’ d a b e  needs to reflect 
this occurrence. Otherwise, the new employee will be 
double counted in the area’s forecast. The new 
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employee’s name will appear in the existing 
employees’ d-list, which is copied from PeopleSoft 
each month, once he or she has been added to the 
payroll. In the new employees dcube, a “YES” needs 
to be inputted into the “Now an existing employee” 
cell in the month the employee begins and is added to 
the existing list. Hence, there will be a one month lag 
in the forecast, since the existing list will not indude the 
new employee until he or she has begun working. 
Also, the forecast is done a month in advance. 

For example, the November forecast is due in October. 
The November forecast contains the existing 
employee list for October actual. A new employee 
may begin work on November 1“ and will appear on 
the existing employee list for November actual, which 
will be used for December‘s forecast. Therefore, the 
new employee will be marked existing in the month of 
November as part of the December forecast since the 
December forecast contains November actuals. If a 
user does not mark the new employee as existing for 
November in December‘s forecast, he or she will be 
double counted in the area’s or cost center‘s forecast. 

If a user predicts a new employee in October‘s 
forecast with a July start date, and in April he or she 
realizes the new employee will not start until August 
instead, the forecast may be adjusted. The user must 
zero out the new employees starting hourly rate for 
July so that no labor costs are forecasted for that 
month. The new employee’s costs will then be 
forecasted from August and beyond instead of 
beginning in July. 

Q+- Changes cannot be made to months that already became 
actual months. Hence, in the example above, the 
forecasts for October, November, December, January, 
February and March will a// contain new employee 
information for July and beyond. April will be the first month 
forecasting the new employee will begin in August. 

Accountina for Overtime bv Ernplovee CateapCy 

This button opens the overtime by employee categoly 
dcube. Users may input the average overtime 
hours employees will work by their category such as 
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PSE 1 or UNW N03. Do not enter total overtime 
hours for all employees within the category. 

Each employee in that category will receive the 
amount entered in his or her category once the update 
buttons explained below are executed. Therefore, 
each employee’s overtime does not have to be 
entered individually. However, some degree of 
accuracy will be lost using this method. 

Users will input data for all forecasted years. The FPF 
will update the d-cube with budget information. 

The update buttons are explained below: 

UDdate New EmDlovees with Overtime Hours 

This button updates the new employees’ cube 
with overtime hours entered in the overtime by 
employee category d-cube. 

IS This update must be run each time a new employee 
is added or the new emp/oyee wil/ not be assigned 
any overtime. 

UDdate Existinq EmDlovees with Overtime Hours 

This button updates the exjsting employees’ cube 
with overtime hours entered in the overtime by 
employee category d-cube. 

Workina with Function Work Order SDlits bv Emolovee 
Cateoory 

This button opens the function work order split by 
employee category d-cube. Employees’ functional 
distribution will be entered by employee category in 
this screen for the Utility companies. Users will enter 
the percent of an employee category‘s total time 
associated with a particular function and copy 
distribution across to all forecasted months. This 
option will save users time by not having to update 
each individual’s function work order distribution. 
However, some degree of accuracy will be lost with 
this method. 

Users will input data in all forecasted years only. 
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The update button is explained below 

Allocate Labor Bv Employee Cateqory 

This button allocates the function work order 
percentage back to all new and existing 
employees based on their employee category. 

If a user utilizes the function work order split or 
overtime hours by employee category, he or she may 
change individual employee’s information if necessary 
by accessing the regular d-cubes. However, he or 
she must <click> ”Yes” when opening the function 
work order splii cubes for new or existing employees 
when asked if the function work order split by 
employee category was used. The d a b e s  will then 
update according to the function work order split by 
employee category. 

w For instance, the user may have allocated ten hours of 
overtime to all PSE 2’s. However, the user knows John 
Smith never works overtime. The user may go into John 
Smith’s record in the existing employees labor cube and 
set John’s overtime to zero. The orderin which this 
process is done is extremely important. The user must 
then lock John’s overtime to prevent it from being 
overwritten each month. 

If user changes individuals records for overtime or 
function work order split and use the OPTIONAL short 
cuts, he or she must lock the information. 
Otherwise, each time the short-cut update buttons run, 
they will overwrite the information he or she changed. 
However, the information must be unlocked once the 
month becomes an actual month or the actual 
information will not update that cell. 

w If a user uses the function work order category split, labor 
reprts and new and existing employee function work order 
split d-cubes will be updated automatically even if they are 
not re-opened. 

Each individual area or cost center will contain only 
functions or accounts they have previously charged 
instead of all functions or accounts that exist. If an 
area or cost center needs an existing function or 
account added, the user must contact Planning and 
Control to have it added to their list. If an area or cost 
center needs a new account or function set up, the 
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user must contact General or Corporate Accounting as 
well as Planning and Control. 

Accountina for Function Work Order Solits for Existing 
ErnDlovees 

Message appears when opening the d a b e  asking 
“Are you using Function Work Orders Split by 
Employee Category?“ 

Choose “Yes” - See note on previous page under 
function work order split by employee 
catesory 

Choose “No” - The PeopleSoft function or account 
distribution will default for actual months. If 
the user wants to use the default 
percentages, the user must then copy these 
percentages across all the future forecasted 
months so that all the years contain 
information. 

WARNING: Be Careful with Function Work Order 
Split or the Errors Below May Occur 

If choose “Yes” and did not use Function Work 
Order Split by Employee Category- All function 
work order splits will be zeros even if the user 
previously entered information here. However, the 
actual months will still contain the correct information 
since they will default from PeopleSoft. 

If “No” and used the Function Work Order Split by 
Employee Category-The d a b e  will still be updated 
with the information in the category split. The 
information will populate the dcube because the 
Allocate Labor by Employee Category button 
explained previously updates the dcubes for both new 
and existing employees. 

w If an employee books time worked in more than one area 
or cost center, then his or her function work order or 
account split shouM still equal one hundred percent. 
However, the employee’s regular working hours should 
only equal the actual amount of time he or she worked for 
that area or cost center and not the monthly total. In 
addition, this employee will be counted in each area’s or 
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cost center's headcount. Each employee in an area that 
books any regular hours worked in a period will be counted 
as one in the headcount. 

Accountina for Function Work Order SDlits for New 
Emplovees 

See Accounting for Function Work Order Splits for 
Existing Employees because the same notes apply here. 

Tips for Working With 
Other Costs 

Makina Adiustments to Other Costs 

In this dcube, all of the forecast region is protected. The 
current year budget information will defauit here for 
forecasted months. Otherwise, actual information will 
populate this region. If a user needs to adjust the current 
forecast, he or she may do so in the adjustments region. 
Hence, the information in the forecast region will then 
contain budget plus adjustments for forecasted months. 

w Users may only forecasted months, not actual 
months. 

Usina the Grow Command 

In the previous system, an inflation table applied to 
inputted other costs calculated inflation for the 
forecasted years. However, in the FPF, inflation can 
be accounted for using the grow command in the other 
costs cube. Users must enter the current cost (ie. 
$1,000) in forecast+l and hit enter. Then, type the 
grow command, "grow 3c" for example, in the same 
cell, and hit enter. The other costs will then grow and 
compound by three percent in forecast+2 (ie. $1,030), 
and forecast+3 (ie. $1,061). The organization of the d- 
cube window is important when using the grow 
command. The versions d-list, which contains forecast 
+I ,  forecast+2, and forecast+3, must be displayed as 
a column or row in order to use the grow command. In 
addition the command should be applied to the Total 
Function item in the Function by Area d-list and the 
Fiscal Year Total d-list after all other costs have been 
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